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1.Introduction

Mercury is supporting software for the DST temperature recording Data
Storage Tag. Mercury can run under Win98, WinNT, Win2000, WinXP
and Vista. This manual takes you step-by-step through the program
installation, hardware connections and use of the Mercury Program.

This manual guides the users of DST through the operation of the
recorder. Setting the operating parameters as well as data retrieval
requires access to a PC computer with a standard RS-232C serial
interface or USB.

The users of Mercury will receive free updates of the software. Updates
of Mercury will be available for free download at:

http://www.star-oddi.com/Online-Support/Software-updates/.

Please note that the downloaded file has to be installed into the existing
Mercury folder. The update alone is not a complete program and therefore
will not work like that. Follow the instructions on the update website for
correct installation.

DST is a compact microprocessor-controlled temperature recorder with
electronics housed in a waterproof housing.

The temperature sensor is located behind the membrane as shown on the
diagram below.

Figure 1.1 Temperature sensor

Temperature Sensor
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2.Program Installation

This chapter describes how to install and uninstall the Mercury software
on your PC computer.

2.1 Install

The installation program is on the Mercury CD. Insert the CD into your
compact disc drive. To install the program, follow the automatic
InstallShield Wizard.

Follow the instructions on the screen. You will be prompted for a directory
name for your Mercury program.

2.2 Uninstall

To uninstall the program, do the following:

1. Click on the Start button in Windows.
2. Go to Settings and Control Panel.
3. Choose Add/Remove Programs.
4. Choose Mercury and click on Change/Remove, and ‘Yes to all’.
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3.Preparation

This chapter describes preparations that should be carried out before
connecting to the recorder.

Start Mercury and the following window appears:

Figure 3.1 Mercury Main Window

3.1 Select Recorder Type

Mercury is compatible with other Star-Oddi instruments. A recorder type
must be selected before connecting to the recorder. The default setting in
the software is set to DST micro as a recorder type. Change the recorder
type to your type of DST by doing the following:

1. Choose the File menu and the New Recorder Type command.
2. Select the appropriate DST as a recorder type.
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Figure 3.2 Select a new Recorder Type

Before connecting to the recorder, it is important that the clock on the PC
computer is correct. This is important since the recorder automatically
downloads the PC clock settings.

3.2 Configuration of the Communication Port

It is necessary to define which serial port on your PC computer you will
use for connecting the Communication Box. This is done in the following
way:

1. Choose the Communication command in the Settings menu.
The Communication definition dialog box appears.

2. Select a serial port for communications.
3. Choose the OK button.

Figure 3.3 Communication Port Configuration
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To check which communication ports are available on your computer,
open your Device Manager. On Windows XP you can do it following way:
Control panel > system > hardware > device manager.
Under Ports you can view all available ports. Make sure that the port you
are intending to use is enabled: right-click on the appropriate port and
select properties. Under ‘Device usage’ it should state ‘use this device
(enable)’.

Figure 3.4 Enable Communication Port

3.3 Using the USB Serial Converter

If you are using the USB serial converter you will need to install the driver
first that comes on the provided CD. Please, read the ‚Quick Installation
Guide‘ booklet to get further instruction on how to proceed.

After you plug in the USB cable you will see a new communication port in
your device manager, called ‚Prolific USB-to-Serial Comm Port‘. Make
sure that the port is enabled and select the appropriate port in Mercury.
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Figure 3.5 USB Communication Port in Device Manager

mailto:@Star-Oddi


User Manual Mercury Graphic Supporting Software

@Star-Oddi 2010. All Rights Reserved Page 13

4.Communication Box

This chapter provides details concerning the Communication Box and
how to place recorder in the box prior to connection.

4.1 Communication Box

The DST Communication Box is a PC-RS-232C compatible
communication interface, specially designed to communicate with DST
recorders wirelessly via RF (radio frequency). A USB converter plug is
optionally available for the Communication Box.

The Communication Box has three diodes:

1. Red – shows that power is fed from the power supply to the
Communication Box.

2. Yellow – shows that Mercury has made connection with the box,
the appropriate DST has been selected as a recorder type and that
correct COM port has been selected.

3. Green – shows that recorder is in correct position for seeking
connection.

Connect the serial cable between the serial port of the computer and the
Communication Box. Plug the power supply connection to a power-
socket. The voltage from the power supply should be set to 9V, although
there is no damage to use up to 20V. Before inserting the power plug into
the box, it is important to note that the polarity should be:

The polarity is usually shown where the arrows meet on the power plug,
and the power supply. After the power supply has been connected to the
Communication Box, the red light should be on. After Mercury has been
started, the yellow light should be on (if correct COM port is selected).

The box will power the recorder while communicating with the PC. In
case the battery is dead, the PC and interface are still able to connect to
the recorder and retrieve data.

–(O+(minus on the outside and the plus on the inside)
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4.2 Connection Point

In order to get the green light, the red and the yellow light must be on.
The recorder is inserted into the hole of the box as shown in the figure
below:

Figure 4.1 Inserting Recorder into the Communication Box

If the recorder is wet/damp, then please wipe it dry before inserting it into
the box. The spherical end of the recorder faces down and flat end faces
up. Recorder is rotated until the green light illuminates.

When green light is on, communication can be established with the
software. For best connection conditions, recorder is placed in the middle
of the area where the green light is on.

For our latest products we have added a mark on both the housing and
the Communication Box to help finding the right position. Simply turn the
logger until the small grey mark on top of the sensor meets the marking
that is drilled into the surface of the Communication Box.
If the recorder fails to connect, please refer to the Troubleshooter.

Some recorders have marking, a dot or a line, on the flat end. This
marking matched against a similar marking on the Communication Box will
give the best position for communication.

Communication Box

DST
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Extra Ground Connection
The black connector in the back of the new Communication Box is a
ground connector that can be used to ground the box, with the black wire
with the alligator clip that is included. Normally, this should not be
necessary. Extra ground wire could be needed if the there is a lot of
electromagnetic noise (like powerful electronic equipment on board
vessels), when the Communication Box is being used. If you need to use
the wire you plug it in the Com Box and clip the other end to anything that
has ground connection (on a vessel e.g. the iron hull of the boat is always
grounded).

4.3 COM Connection

Figure 4.2 Communication Definition

Choose Settings-Communication-Serial Ports to display available ports
(see figure 4.2). Com ports up to COM255 can be selected.
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4.4 Com Port Wizard

Figure 4.3 Com Port Wizard

Choose Wizards-Com Port to enter the Com Port wizard (see figure
4.3). The wizard goes through available ports and activates them one at a
time and asks the user to confirm that the communication box displays a
yellow light.
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5.Using DST - Tutorial

This chapter guides users in 8 quick steps through the process of utilizing
Mercury to set up DST prior to recording and data retrieval.

5.1 Mercury Set Up

Step 1 - Start Program
Start Mercury as described in chapter 2. Remember to carry out the
software preparation outlined in chapter 3.

Step 2 - Connect
Connect the Communication Box as described in chapter 4. Insert DST
into the hole in the box, and twist the recorder until the green light
illuminates on the box.

Step 3 - Connect to the Recorder
Choose the Recorder menu and the Connect command. The window in
figure 5.1 appears.

Figure 5.1 Connecting and Retrieving
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Once the connection has been established, a window appears with
information on the recorder’s mode (see figure 5.2).

Figure 5.2 Connecting to the Recorder

Press OK. The Recorder is now on-line, as indicated at the bottom of the
Mercury window.

Connection Time Registration
Each time Mercury connects to a Recorder, the PC time and recorder
time is registered to a binary file, with a CLK extension. This information is
also saved to a text file with the extension CCT.
Another text file is created with the extension CCD, containing various
information, for example on previous connection and time comparisons,
depending on the status of recorder.
If a previous CCT file exists and the recorder was in sleep or slumber
mode, a PC vs. recorder clock comparison is calculated, indicating
difference in seconds and ppm.
If the recorder was in measurement mode, then a drift calculation is
performed, based upon PC-time comparison to the recorder’s clock and
measurement sequence.
The RIT file contains partly the same information as the CCD file.
Upon retrieving date from a recorder and converting the data, the last
measurement retrieved time and the next scheduled measurement time is
compared to the PC time. The results are added to the CCD file and the
MIT file.
Note: If the retrieved number of data does not match the last measured
number of data, erroneous results are to be expected.

Step 4 - Set new Measurement Parameters
(If the recorder has already been set up to record data and you want to
retrieve data, go directly to step 6).

Choose the Edit menu and the New Measurement Sequence Definition
command. The following window appears:
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Figure 5.3 Measurement Sequence Definition

Select the start time of recordings (date-month-year, hours-minutes).
Set the sampling interval (hours-minutes-seconds).

If the user wants to program several recorders with the same sampling
interval and start time, it is recommended to select Multi mode. By
choosing Multi mode, the settings are fixed; giving each recorder
connected to thereafter, the same settings. The recorders connected to,
following the first recorder; automatically get the same settings as the first
recorder. This saves time in the programming process. After the settings
have been selected, press the OK button. For programming more than
one sampling interval, please refer to chapter 9 Multiple Intervals.

If the user wants to program several recorders with the same sampling
interval and start time, it is recommended to select Multi mode. By
choosing Multi mode, the settings are fixed; giving each recorder
connected to thereafter, the same settings. The recorders connected to,
following the first recorder; automatically get the same settings as the first
recorder. This saves time in the programming process. After the settings
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have been selected, press the OK button. For programming more than
one sampling interval, please refer to chapter 9 Multiple Intervals.

The three buttons Use Template, Use Sequence, and Previous are not
commonly used, but can be handy when wanting to use a previously
programmed sequence. To read more about templates see chapter 8.

Step 5 - Start a new Measurement Sequence
To set the recorder in Measurement Mode (start recording), choose the
Recorder menu and Start New Measurement Sequence command. The
window in figure 5.4 appears.

Figure 5.4 Start New Measurement Sequence

Once the new measurement sequence has been downloaded into the
recorder, a window appears on the screen in order to verify the settings
(see figure 5.5).
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Figure 5.5 Start New Measurement Sequence

Press OK and the recorder will be in Measurement Mode.

NMS Calculation
Upon setting up a NMS the estimated measurement sequence is
calculated and memory and battery energy usage predicted. The results
are written to a text file, bearing the recorder name with a NMS extension.
If a recorder has not been selected then the file bears the recorder type
name, still the NMS extension.

The file is placed in the Mercury\NMS directory.
An example of the *.NMS file is shown in fig. 5.6.

Figure 5.6 Results from NMS Calculation
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When starting the recorder in a NMS, the *.RDT file shows the sequence
settings, plus information on the sequence time duration and battery
usage (same as in the *NMS file).

Step 6 - Retrieve Data
Choose the Recorder menu and the Retrieve Data command. The
window in figure 5.7 appears.

Figure 5.7 Retrieve Data from Recorder

The window in figure 5.7 shows the data retrieval progress in bytes, time
elapsed and number of packs received.

Data will be uploaded from the recorder and presented in graphical and
tabular form. With default settings, Mercury automatically creates a sub-
directory in the Mercury directory, named after the DST type. In the DST
type directory, a directory named after the recorder’s serial number Unnnn
is created; U is the letter for DST micro. All files related to the recorder
are automatically saved in the serial number directory. The default data
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directory can be viewed in the Settings menu, and Directories. The user
has the option to define a new data directory path if desired.
The data is retrieved in a non-destructive manner. This means that you
can repeatedly read the data without erasing it from the memory. Each
time data is retrieved, a new file will automatically be created. The name of
the data file consists of the measurement sequence number and the serial
number of the recorder. The recorder cannot be loaded with new settings
if it contains data that has not been retrieved. This is a safety feature
which prevents data from being accidentally lost. New recordings
overwrite previous recordings that have been retrieved.

Step 7 - Disconnect
After the recorder has been set up for measuring, it should be removed
from the Communication Box. If the recorder is not put in measurement
mode, it will automatically go into sleep mode when removed from the
box.
If you simply remove the tag Mercury will still have the recorder in on-line
mode in the program and won’t allow selecting another recorder or using
certain options. Select Recorder > Disconnect to go into off-line mode.

Step 8 - View Data
If data is retrieved from the recorder, a new file will automatically be
created and opened in graphical and tabular form. To open existing data
files on the computer, choose the File menu, Select Recorder command,
and then the Select Measurement command. When a data file has been
opened, a new window appears with the data shown as a chart and a
table. The next chapter will describe in detail how to view and process
data.
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6.View Data

This chapter describes how to open a data file and the options available
in Mercury for viewing the data.

6.1 Open Data

To open an existing data file that has already been retrieved, do the
following:

1. Choose the File menu and the Select Recorder command. When
a recorder has been selected, its serial number will be displayed in
the blue top bar of the software.

2. Select the data file by choosing the File menu and the Select
Measurement command.

The name of the data file consists of the measurement sequence number
(number of times the recorder has been set up to measure) plus the serial
number of the recorder. The ‘Measurement sequence no.’ can also be
seen at the bottom in the Mercury window. When the data file (.mid) has
been selected, the chart and data tables are opened. The following figure
shows a chart and data table which have been opened:

Figure 6.1 Chart and Data Tables of an open File
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6.2 Import

Data files from other recorders than DST can be imported into Mercury
and viewed as charts and tables. The imported file must be a text file with
the extension DAT, and with Mercury’s conventional DAT file structure.
See more about data files and headers in the Appendix.

6.3 Buttons

When the chart is opened, buttons related to the chart are displayed.

Active Series List
This button can be useful when working with a multi-sensor recorder, in
order to select which parameters to display in the chart. For example,
when working with a chart displaying temperature recordings, the user
can hide the temperature line in the graph.

Horizontal/Vertical Gridlines
These two buttons give the option of hiding/displaying the
horizontal/vertical gridlines in the chart.

Data Point Marker
This button gives the option of displaying/hiding data points in the chart.

Histogram
The chart can be shown as histogram, displaying the distribution of values
by percentage.

mailto:@Star-Oddi


User Manual Mercury Graphic Supporting Software

@Star-Oddi 2010. All Rights Reserved Page 27

Click the histogram button and the following window appears:

Figure 6.2 Histogram

Under Bin Settings there are two options, Default and User. Choose
User to select the number of bins and the minimum and maximum values
you wish to display.

The Histogram can be printed out by clicking the Print button.

Save Window Data
Retrieved data is automatically saved, but if changes are made with the
graph, for example with the time scale, the save button enables the user
to save the graph (as a DAT file).

Print Chart
The chart can be printed. Please see chapter 7 for more details.
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Zoom Out
Click this button to zoom out the chart.

Adjust Axis
This button adjusts the axis in order to display all data within the zoomed
timeline.

Transfer data to PatternFinder
Click this button to transfer data to PatternFinder

Chart Edit
By clicking this button, the following window appears:
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Figure 6.3 Editing Chart

This button gives several options regarding the look of the graph. The axis
can be defined (max. and min.), titles and legend can be set visible. Under
‘Panel’ the color of background, borders and gradient can be selected.
Under ‘Walls - Back’ the colors and gradient of the graph itself can be
selected. The ‘Visible’ option must be enabled to activate the features.
The graph can be exported in formats as jpg, gif, bitmap, metafile, pdf,
htm and svg.

Templates
If the changes have been made to the graph under ‘Chart Edit’, it is
possible to save that template. It is also possible to load a previously
saved template (i.e background).
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Hide/Show Table
The data table can be either displayed or hidden using this option.

6.4 Using the Mouse

Max and Min Values
Click once on any line in the chart, and the maximum and minimum values
for that line (sensor) are now shown. A straight vertical line should be
visible in the graph (to the left). By clicking on this line and holding the left
button on your mouse down, the line can be dragged through the chart
and the data table will scroll along with the position of the line.

Zoom
The chart can be zoomed in on by holding down the left button of the
mouse, and using the cursor to create a box to the right, around the
desired area to zoom in on.

Scroll the Chart
The chart can be scrolled upward, downwards and to the sides, by
holding down the right button of the mouse and moving the cursor in the
desired direction.

Go back to initial View
To go back to the initial view of the chart, simply hold down the left button
of the mouse and make a box to the left with the cursor. The position of
the box on the chart is irrelevant.

Change the Axis
By double clicking on the X and Y-axis, the measurement time and
temperature range can be changed.

Change the Title
To change the title of the chart, double click on the title of the chart
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6.5 The View Menu

When a recorder has been selected, the files in the View menu can be
opened.

Data Trend and Table
This view is automatically selected when data is retrieved or a data file is
opened. If the chart is closed, but a recorder has been selected, this
command can be selected to view the chart. The software will open the
latest chart that was viewed for that recorder.

Recorder Information (RIT)
This is a text file containing basic information about the recorder, serial
number, production date, estimated battery life etc.

Recorder Calibration Information (RCI)
This text file contains information about the calibration constants of the
recorder, calibration range of the parameters. The range is both showed
as decimal values (DV) and unit values (UV).

Recorder Download Information (RDT)
This text file contains information about the measurement sequence that
was last downloaded into the recorder, including the start time, sampling
interval and the measurement sequence number.

Viewing Text Files
Under <View\Text files> the user can select a text file, via a file browser,
for viewing.
This option is meant to give the (advanced) user a chance to view files
that are not directly supported for viewing in Mercury, but are a part of the
Mercury documentation system.
The files that the file browser accepts must have the following extensions:

 TXT
Frequently, users copy Mercury data to text processors and
spreadsheets, like Word and Excel, and later save the data as TXT
files for viewing in other applications.
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 INI
There are a number of INI files that Mercury uses for store settings.
These files are described in the Appendix under ‘Information files’.
The latest members in the INI files family are the Template files.

 DAD
This is the original data file. It contains the raw data (in Ascii format)
retrieved from recorder. The DAD together with the MID are
converted to the DAT file.
A word of warning: The DAD file should never be tempered with, as
that might give cause to erroneous data conversion.

 CCT
Every time Mercury connects to a recorder, the PC time and the
recorder’s clock data are stored in a <recorder name>.CCT file.

 CCD
Every time Mercury connects to a recorder, the PC time and the
recorder’s time are compared to the last CCT, if found, and stored
in <recorder name>.CCD file, <measurement sequence
name>.CCD.

 NMS
Upon completion of a NMS editing session, estimation of memory
and battery usage is calculated and the results placed in a NMS
file, which is then displayed to the user.

SNMS LOG File
To improve the “Start New Measurement Sequence”, SNMS,
indication/registration of success or failure, a log file for each recorder
type is placed in the Mercury directory.
The log file name, for DST micro, is DSTU.LOG, i.e. the same naming
convention as for the type INI files.

Each time a SNMS is performed then the appropriate LOG file is
updated.
The LOG file can be viewed via “View\SNMS Log file (LOG)” (see figure
6.5).

In addition to the LOG file, if an error occurs during the SNMS, the MDD
file is created as a text file, with a description of what went wrong. This
MDD file is displayed as a clear message for the user:
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Figure 6.4 The MDD SMNS Error Message

Usually the MDD file is a binary file, and the MDT is created from the
MDD. If the SNMS is repeated successfully the MDD file is overwritten
and the MDT file created (figure 6.5).

Figure 6.5 Example of a LOG File
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Measurement Data

Measurement Download Definition (MDT)
This text file contains information on data downloaded into the recorder
for the measurement file being viewed, including the start time and
sampling interval.

Measurement Information (MIT)
This text file contains information concerning the measurement upload
time, start date, start time and number of measurements in the
measurement data file.

Conversion Information (CIT)
This text file contains conversion information on the units and the data file
format.

Statistics in CIT:
The CIT has been enhanced with more detailed information on the
converted data.

As can been seen in figure 6.6, the statistical data, that have been
tabulated, are split into two sections, the Unit values statistics and the
Decimal value statistics. Values are given for each parameter. The file can
be viewed under ‘View\Measurement Data\Conversion Information (CIT)’:

Figure 6.6 Statistics in CIT File
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A one line description/comment is available for the user to fill out in the
Reconvert data menu. This description is placed in line two of the CIT file.

Out of Range (OOR)
This text file lists all the measurements that were outside decimal value
calibration range, as well as the unit value range. If correction has been
performed according to the user definition, then the corrected values are
show. See more about ‘out of range’ in chapter 8.

Binary Data (DAB)
This file contains raw data of the measurements in the data file.
Calibration files are not calculated into the data.

View DAB Files as Trend
When converting the DAD -> DAT the DAB file is created simultaneously.
The DAB shows the recorder’s native data, i.e. decimal values in the
range 0-4095. These values originate from the recorders 12 bit ADC
(Analog to Digital Converter).
It can be of interest to view the data in its native form, for example to spot
saturation/out of range intervals.

A new header has been designed for the DAB and Date and Time
columns have been added to the DAB file. Thus the DAB can now be
viewed graphically as a trend via:

‘View\Data Trend and Table\Decimal (Binary) data (DAB)’

mailto:@Star-Oddi


User Manual Mercury Graphic Supporting Software

@Star-Oddi 2010. All Rights Reserved Page 36

Figure 6.7 DAB Trended

Mercury cannot view older DAB files, and will inform the user to that
effect, if an attempt to view an older DAB file is performed. By
reconverting the data, a viewable file is produced.

Converted Data (DAT)
This is the text file for the converted data. The DAT file as well as the
other text files can be opened in other programs (Excel, Notepad, Word
etc.).

Time Synchronic Data (TSD) and Rate of Change (ROC)
If the TSD and/or ROC file creation has been enabled under the Settings
menu, then it’s possible to view these files.

You can find more in chapter 8.7 TSD and chapter 8.8 ROC and more
about files in the Appendix.
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Mercury Log
Mercury stores events in the file <Mercury.log>. The events are:

 Recorder Connected
 Retrieving data from a recorder
 Uploading a measurement sequence to a recorder
 Recorder disconnected.

This file can be opened in Mercury under <View/Mercury Log> or by
opening it with a text editor.

6.6 Opening Data in Excel

The Mercury software automatically creates a text file with the data, called
*.DAT, when retrieving data. This text file can be opened in Excel and in
other programs.

Under the ‘Settings’ menu, ‘Preferences – Data File Format’, the default
factory settings is set to ‘joined date and time’. If this option is not
disabled, the following is performed, for opening data in Excel:

1. Excel is started.
2. The *.dat file is found from ‘File/Open’.
3. Excel comes up with the ‘Text import wizard’. This is a three step

process:
a. No changes should be made in first step, so press the next

button.
b. ‘Text qualifier’ should be set as ‘None’.Press the next button.
c. Column 2, that is date and time, is set as ‘Text’. Press the

finish button.
4. You can now create the graph with columns B, C and D.
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7.Printing

All charts and text files can be printed from the Mercury software.

7.1 Charts

Open the chart you want to print out and select File-Print on the menu
bar. The following window appears:

Figure 7.1 Print Preview

Orientation
The chart can be printed in either portrait or landscape format.

Margins
By changing the margins, the chart’s length and width can be re-scaled.
The margins can be varied by either changing the numbers given for the
left, right, top and bottom margins, or by moving the margin lines with the
mouse by pressing and holding the left button as the lines are dragged.
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Move
When the cursor is located on the chart, a hand becomes visible. By
clicking on the graph and holding down the left button of the mouse, the
graph can be moved around the page to a desired position.

Details
The size of horizontal and vertical gridlines as well as the texts on the X
and Y-axis can be re-scaled by using the scroll bar. The number of
gridlines is increased when the bar is moved to the left.

Another way of printing out a chart is opening the chart you want to print
out and clicking the Print Chart button on the chart bar.

7.2 Histogram

To print out a histogram, open the chart which histogram you want to print
out and click on the Histogram button on the chart bar. The following
window appears:

Figure 7.2 Histogram

Click Print and the window in figure 7.3 appears:
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Figure 7.3 Output Options

To change the selected printer, click Setup and select another printer.

To see a preview of the print out, select Preview under Report
Destination and click OK (see figure 7.3 and 7.4).

Figure 7.4 Report Preview
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7.3 Files

Activate the file you want to print out and select File-Print. The following
window appears:

Figure 7.5 Output Options

The dialog window in figure 7.5 has the same functions as the one in
figure 7.3.

Note that as some of the files are very large, it is recommended to
highlight the data you want to print out before printing.

Figure 7.6 Report Preview
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8.Settings

This chapter describes the options in the Settings menu. These settings
are automatically saved when exiting the program.

8.1 Directories

The path definition can be set as Default Mercury path structure or User
defined paths. Choose the Settings menu and the Directories
command. A dialog box appears:

Figure 8.1 Directory Path Definitions

Default Mercury Path Structure
By choosing a DST recorder type, Mercury automatically creates a DST
type directory in the ‘Mercury’ directory that was created when the
software was installed on the computer. Upon connection with DST,
another directory is automatically created under the type directory, which
is named after the serial number of the recorder. All data files and other
files related to that recorder are stored in this ‘serial number’ directory.
Each DST recorder has its own data directory.
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User Defined Paths
If this option is selected, the User definition data directory becomes
active. The data path/directory can be defined by the user. For defining a
path on the network, the particular drive must be mapped (under
Windows Explorer) in order to browse for the drive under ‘Add data path’.

Browse first in User Directory
With default off, the user is first directed to the path where Mercury was
installed, to look for the INI file. If this option is enabled, Mercury will start
looking for the INI file in the user-defined directory. More information on
files and directories can be found in the Appendix.

Create Recorder Directories
This option is default on, and means that a recorder type and serial
number directory is created for every recorder connected to.

8.2 Preferences

Units
By choosing the Settings menu, the Preferences command, and Units, a
dialog box appears:

Figure 8.2 Unit Dialog Box
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Selecting Units
The user defines whether degrees Celsius or Fahrenheit are used as a
unit for temperature measurements and Bar or psi for pressure
recordings. Number of decimals for the values can be selected.

Data File Format
By choosing the Settings menu, the Preferences command, and Data
File Format, a dialog box appears:

Figure 8.3 Data File Format Dialog Box

Date Format
The user defines whether the date should be shown as dd mm yy (day,
month, year), or mm dd yy (month, day, year).

Date Separation
The user defines whether a dot, slash or dash should be used to separate
the date.
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Time Separation
The user defines whether a colon or a dot should be used for the time
separation.

Field Separation
For the text files created, the user defines whether a tab or a space
should be used to separate the fields.

Date and Time Column Definition
If data is to be exported to other programs, it is recommended that the
date and time be joined in one column.

Select Decimal Point
The user defines whether a comma or period is used for the values
displayed in Mercury and for text files that are created.

Measurement Interval
The default setting in the software is set to ‘Single interval’, as most users
utilize. By choosing ‘Multiple intervals’ the software enables programming
of several different sampling intervals, enabling memory saving efficiency.
By choosing the Settings menu, the Preferences command, and then
Sampling Intervals, the following dialog box appears:

Figure 8.4 Measurement Intervals

By choosing ‘Multiple intervals’ the effects are shown in the dialog box
that appears when you choose the New Measurement Sequence
Definition command under the Edit menu. More details about multiple
intervals in chapter 9.
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8.3 Connection

Choose the Settings menu and the Connection command. A dialog box
appears:

Figure 8.5 Connect and retrieve Data Options

Perform CRC Test when Retrieving RID
The CRC test is a safety check performed by the software when
retrieving Recorder Information Data (RID). If the CRC test is not
successfully carried out, it means that some errors have occurred in the
transfer of files or constants, between the recorder and the computer. If a
CRC test failure occurs, the user is notified. Normally, this option should
always be selected.

Check Data Echo in SNMS
Normally the Check Data Echo in SNMS and updating settings in
Disconnect and Retrieve Data should be enabled (figure 8.5). In case of
communication problems using a USB serial converter the user can try to
disable this option, as it will bypass data echo checks, resulting in less
restriction on communication protocol.

Automatic Data Retrieval upon Connection
By enabling this option, the software will automatically check for data in
the recorder upon connection. If this option is not enabled, data retrieval
is done manually by choosing the ‘File’ menu, and ‘Retrieve Data’
command.
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8.4 Retrieve Data

Choose the Settings menu and the Retrieve Data command. A dialog
box appears:

Figure 8.6 Retrieve Data Options

Retrieve Number of Data
With default settings, the software retrieves the last measurement
sequence recorded. The user has the option of retrieving older data that
is still in the recorder’s memory. By choosing the User defined number
of data, the number of measurements retrieved from the recorder can be
set. When retrieving data, it is optional to view the Data Trend after
conversion.

As the complexity of measurement intervals give incoherence in the
calculation from measurement number to the number of data byte to
retrieve, the user has the option to define number of bytes to retrieve. Also
when not online working with measurement data, it is optional to view the
Data Trend after a Sequence Selection.

If for some reason or another it becomes necessary to retrieve data more
than once or even several times, the previous DAD and MIT files are not

mailto:@Star-Oddi


User Manual Mercury Graphic Supporting Software

@Star-Oddi 2010. All Rights Reserved Page 49

overwritten before a backup has been made. The backup files are in the
same directory as the “original” or the last DAD file.

A backup number system is in use that marks the first retrieved file as
number one, the second number two etc. The number sign #, is used to
identify the backup up files.

Thus if a data file has for example the name 25M1106.DAD then the
backup file, that was the first retrieval, gets the name 1#25M1106.DAD,
and the 25M1106.MIT file that is associated with the DAD file, is backed
up as 1#25M1106.MIT.

8.5 Re-Conversion

Choose the Settings menu and the Re-Conversion command. A dialog
box appears:

Figure 8.7 Reconvert Menu

With all the options in Mercury, the user may want to do a lot of
reconverting (<File\Reconvert Data>) on data files after defining the
preferences; changing units, data formats, OOR settings, TSD settings,
ROC settings, offset settings and converting different sections of the data
file, all of which result in numerous files. To ease the task of remembering
settings and results and/or renaming and copying files, a backup system
of reconverted files has been implemented.
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A reconvert number is now associated with each sequence. This number
is saved in the recorder’s INI file and updated each time a reconvert is
implemented. A copy is made of the DAT, CIT, DAB, OOR, TSD and the
ROC files with the reconvert number attached to the filename.
Thus if a data file is for example named 5M1024.DAT, i.e. sequence 5 for
DST milli 1024, then after the first reconvert, a copy of the DAT is named
1-5M1024.DAT and the same naming convention is applied to the other
files.

Each time data retrieval is performed, a subdirectory, which name is the
sequence number, is created in the data directory, where a copy of the
“original” DAT, DAB,CIT and OOR files is placed. These files have a “0-“
in their names. All the reconverted files are placed in the sequence
directory. The reconvert number system is optional, and the user can
disable it in the reconvert menu. When the reconvert number system is in
use, and when viewing trended reconverted data, the reconverted
“backup” file is displayed, thus eliminating the need to close the “last”
converted trend data window.

8.6 Out Of Range

If measurements are outside the calibrated range, they may seem
inaccurate. The out of range measurements are shown in the OOR file
(View – Measurement Data – Out Of Range Data). The min and max
calibration points are given in the RID file, and in this case it should be
sufficient to go directly to ‘Edit – Reconvert Definition – Data Definition’,
and choose ‘RID values’ under ‘Out of range decimal values settings’.
Data is then reconverted by choosing ‘File – Reconvert Data’. You can
find more about reconverting in chapter 10.

The user can also define the ranges. Choose the Settings menu, Out Of
Range - UV and DV definition command. A dialog box appears:

mailto:@Star-Oddi


User Manual Mercury Graphic Supporting Software

@Star-Oddi 2010. All Rights Reserved Page 51

Figure 8.8 Set TD Out Of Range (OOR) Parameters

Decimal Values
Decimal Values (DV) are raw measurements, sometimes referred to as
binary data. The decimal value is between 0 and 4095, which is the range
for the 12 bit AD converter. The decimal values are the recorder’s
calibration range. The user should not define the decimal value range,
unless he has obtained these values for that particular recorder from Star-
Oddi.

Unit Values
The decimal values are converted to Unit Values (UV), for example a
decimal value of 2000 could give 20°C. The user can select a specified
range for the temperature. If unit values in the data are outside the
measurement calibration range of the recorder, the user has the option to
set a max. and min. range for these unit values. After selecting the unit
value ranges and pressing the OK button, the following window appears:

mailto:@Star-Oddi


User Manual Mercury Graphic Supporting Software

@Star-Oddi 2010. All Rights Reserved Page 52

Figure 8.9 Out Of Range (OOR) Correction

If no values have been selected for the Decimal Value (DV), no correction
should be selected. If Unit Values (UV) ranges were specified, the user
has the option to change the out of range measurements to the last value
that was recorded before the out of range measurement was recorded, or
have it according to the max/min unit value as specified earlier. In this
case the software will know if the value is under the minimum or maximum
limit. After the correction has been made, the data needs to be
reconverted under File – Reconvert Data, and data will be changed
accordingly.

8.7 Time Synchronize Data (TSD)

Choose the Settings menu, TSD definition command. A dialog box
appears:
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Figure 8.10 Time Synchronic Data Settings

If the user wants to time synchronize two or more data files, it is possible
to select three options: 1 hour, 10 minutes, or 5 minutes. The restriction is
that the sample interval selected must be greater than the initial interval,
and it must also be dividable by the initial interval. For example, if the initial
interval was 15 minutes, only the 1 hour option can be selected for time
synchronizing.

If the ‘Include empty cells’ is enabled, the data tables will be empty for
those measurements in the original file that are not to be shown.

If the user wants to activate this feature, the ‘Make TSD file when
converting DAD-DAT’ must be enabled. For changing the current
measurement file with one of the three intervals, the data must be
reconverted by ‘File – Reconvert Data’.
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8.8 Rate Of Change (ROC)

This new feature gives the user a chance to see how fast the signal is
changing, i.e. the estimated velocity of the signal. This applies to all
measured parameters. The ROC is calculated via a two point numerical
differentiation:

ROC= (P2-P2)/(t2-t1)
P: Parameter expressed in a user defined unit
t: Time (hour, minute or second)

The way the ROC is set up and viewed is very similar to the TSD.
Under ‘Settings\ROC’ the ROC options can be set:

Figure 8.11 ROC Definition

The ROC is only computed when a DAD->DAT conversion is performed,
and when the user wishes. The time units are selectable as hour, minute
or seconds. For small changes it can be convenient to express the ROC
as a milli (10-3) unit. For example if the temperature is in (°C) then milli
degrees Celsius are expressed as (m°C).
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The ROC can be viewed as a trend under ‘View\Data Trend and
Table\Rate Of Change (ROC)’ or as tabulated data via
‘View\Measurement Data\Rate Of Change’.

8.9 Chart

Title
Click on the chart title in the chart window to change the title of the chart.
A dialog box appears:

Figure 8.12 Chart Title Dialog Box

To change the chart title, enter a new text string and press the OK button.

Time Axis
To change the time scale of the chart, click on the X axis scale. A dialog
box appears:
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Figure 8.13 X-Axis Settings Dialog Box

By disabling the Automatic option, the minimum and maximum time values
become active. By clicking on the Change buttons for the maximum and
minimum values, the time range can be specified. By enabling the
Automatic option, the measurement time will go back to the initial range.

Value Axis
To change the scale settings for the value axis, click on either of the Y axis
scale, for temperature. A dialog box appears:
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Figure 8.14 Y-Axis Settings Dialog Box

By disabling the Automatic option, the minimum and maximum
measurement values become active. By clicking on the Change buttons
for the maximum and minimum values, the temperature range to be shown
on the chart can be specified. By enabling the Automatic option, the
measurements will go back to the initial range.

Chart Editor
The Chart Edit button (on every graph) gives access to the Chart Editor, a
multi-option menu, now with a Tree View interface:
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Figure 8.15 Chart Editor

There are four main branches on the tree:

 Series
 Chart
 Data
 Tools
 Export

The tree menu gives access to the same features as the tab menu
described in the user’s manual. Most of the changes invoked are viewable
immediately.
All format and style changes made to the chart, are lost if the data are
viewed again or “Reconverted”, as the *.DAD and the *.DAT file are not
affected by changes made to the chart or the database.

Series
The Series window offers the same features as the “Active Series List”
button.
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Figure 8.16 Format Series

When a particular series is selected, like the Temperature series for
example, a two tab menu is revealed, as seen in fig. 8.16, where the user
can “format” each series, and set “points” in the graph. The tab “Point”
offers visibility to points as the “Data Point Marker” button on the graph,
plus formatting of the points.

Chart
The chart branch has six sub branches:

Axis
Titles
Legend
Panel
Paging
Walls

Axis
There are 8 axes in a normal Mercury chart, the number in use depends
on the recorder type. The Left Axis and Custom 1 axis are always in use,
the latter is reserved for the timeline.
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Figure 8.17 Axis Formatting

Figure 8.17 shows a six tab Axis menu. There are numerous options,
some of which can drastically change the behavior of the graph. The
Minimum and Maximum tabs give options similar to the menu offered
when clicking an axis on the graph, the ticks tab gives access to enable
and disable gridlines, just as in the “Horizontal gridline” and “Vertical
gridline” buttons in the graph.

Titles
The Titles menu shown in figure 8.18, gives access to 4 tiles, each title a
multi line text window, which can be positioned anywhere on the chart.
There are multiple formatting options, six tabs, for each title.
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Figure 8.18 Titles Menu

Legend
The legend menu (see figure 8.19) gives the user an option of showing a
series legend.
The 8 tab menu gives options in styling positioning and formatting the
legend.

Figure 8.19 Legend Menu
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Panel
The Panel menu (see figure 8.20) offers panel format options. Images,
pictures and icons can be imported onto the panel as a back image.

Figure 8.20 Panel Menu

Paging
With the Paging menu, shown in figure 8.21, the data series can be
chopped into pages, with a user defined number of points per page. Only
one page is shown at a time, and the user can scroll through the pages
via the page buttons, that appear (are enabled) on the chart to the right of
the Edit Chart button, when paging is selected.
Paging can be useful for viewing distinct time periods, one at a time, days
or hours for example. No offset is offered and sampling periods and start
time can limit the usefulness of this option.

Figure 8.21 Paging Menu
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Walls

Figure 8.22 Walls Menu

The walls menu, as seen in figure 8.22, gives access to configuration of
four walls, but as Mercury charts are default defined as 2D, only the
“Back” wall is visible.
The Walls menu, has similar options as the Panel menu, when defining a
pattern, via the “Pattern…” button, as seen in figure 16, an image can be
imported and placed on the wall. In fact, as the Back Wall lies “on top” off
the panel, a pattern or an image can enhance an image on the panel, or
the image on the panel can be seen through the wall with the
Transparency option.

Data
In the data menu, seen in Figure 8.23, gives the user access to the
database, upon which the chart rests. Here text labels can be set to each
measurement point. Changes can be made to the time and measurement
values. Changes made to the data, are included when the data is
exported, but if the data are viewed again or “Reconverted” all changes
are lost, as the *.DAD and the *.DAT file are not affected by changes
made to the database.
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Figure 8.23 Data Menu

Tools
Under 'Tools' you will find several options to customize the setting of the
cursor and the appearance of the graph, such as page numbering, font,
font size etc. To active/deactivate the chosen setting check/uncheck the
'Active' box on top of the first page of this menu.

Figure 8.24 First Page of Tools Menu
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Export
Under the Export menu, three tabs offer as many menus for saving data as

Pictures
Native (data)
Data (file)

Pictures

Figure 8.25 Export Menu: Pictures

Figure 8.25 shows options when saving the chart as a picture to a file, or
copy the picture to the clipboard. There are seven format possibilities:

 Metafile
 Bitmap
 JPEG
 GIF
 PDF
 VML
 SVG
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Native
The Native menu, see figure 8.26, data is saved as “Native” *.tee chart
files. Import of these files is not supported in Mercury at the moment.

Figure 8.26 Export Menu: Native

Data
Data can be exported to files in four formats, see figure 8.27.

 Text file (.txt)
 XML (.xml)
 HTML (.hml)
 Excel (.xls)
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Figure 8.27 Export Menu: Data

There are four Include options:

1. Point Index
The point index is the same as the measurement number, but offset
by -1, as it starts in 0 instead of 1.

2. Point Labels
If the user has added text labels to points in the DATA menu, these
can be included.

3. Header
The same headers as are in the DATA menu.

4. Point Colors
This option is not relevant in Mercury.

Another method for exporting is to use the Alt+PrintScreen keyboard
buttons to copy an image of the Mercury window to the clipboard,
thereafter to paste it to another Windows application. When a dialog box
is open, then only that frame is copied to the clipboard.

To copy a part of a data file, for example from a DAT file, then highlight the
part you want to copy and use the Ctrl+C keyboard buttons to copy the
data snippet to the clipboard. Then use the paste-option in another
Windows application to transfer the data from the clipboard.
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Figure 8.28 Highlighted Text to be Copied

8.10Timeline

The timeline is a graphical viewing aide. Every time a file is loaded for
trending, an extra time value is calculated for every measurement point.
These time values form the Timeline. The Timeline is an extra series that
follows the rules of the other measurement series. When the graph first
appears, the Timeline is inactive.

By selecting the Timeline in the Series List (see fig. 8.29), the Timeline
becomes visible as shown in figure 8.30.
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Figure 8.29 Timeline Selection

Figure 8.30 Timeline on a graph showing “Day of the Year”

The Timeline is defined under Settings\Preferences\Timeline.
There are several options for the Timeline, as can be seen in fig. 8.31.
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Figure 8.31 Timeline Options

There is no need to reconvert the data, as every time a data file is loaded,
the Timeline is calculated in accordance with Timeline settings. The
Timeline is not a part of the *:DAT or the *.TSD files, but if the data is
exported (see the Export section), then the Timeline, if selected, will be
included. Thus, the Timeline can also be used for statistical purposes.

8.11Templates

There are two scenarios where templates come in handy:

1. When many recorders are programmed with the same settings
(multi mode), and circumstances are in a way that the user cannot
complete the setup of all the recorders in one session, and he has
to exit Mercury (to continue later).

2. When the user wants to reuse, partly or completely, presumably a
complex and/or lengthy measurement setting.

Saving a Template
The user can now, when editing New Measurement Settings (NMS), save
his work by enabling “Save this NMS as a Template (file)” option (see fig.
8.32), before acknowledging OK from the Edit NMS menu. Having
selected this option and the NMS are OK, then the user has an option to
write a description for the template (see fig. 8.33). Canceling this option
cancels the ‘save template’ operation. The template is an INI file and
saved in the Mercury\NMS directory. The name of the file is
MST<date><type letter>time<Interval mode>.INI.
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Figure 8.32 Template Options in Edit\New Measurement Sequence

Figure 8.33 Saving NMS as a Template
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Using a Template
Templates can be retrieved at a later time to be used directly or modified.
The list of templates is kept in the Mercury\templets.ini file.
As can be seen in fig. 8.32 there are three buttons in the Edit NMS
window, the top button is used for retrieving a template.
As can be seen in fig. 8.34, templates are selected via template name or
description. Parallel to selecting a template, descriptions can be edited
and eventually templates deleted.
The recorder type and interval type, which the template was based on, are
visible for each template.

Figure 8.34 Template Selection

Templates can be used across recorder type boundaries and interval
types.

Things to keep in mind when selecting a template are:

 Single interval templates converted to a multiple interval NMS. All
seven intervals are the same.

 Multiple interval templates converted to a single interval NMS, set
the interval as interval one.

 Start time in the past is not allowed as will be apparent when exiting
the Edit NMS window.

 Some recorder types are less compatible than others, an example
of that is a DST milli template converted to a DST GPS NMS.
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The user is returned to the edit window after selecting a template. If the
selection is not as what the user expected the “Previous” button will
return the previous setting.

The user has one more option to quickly set up the NMS. The button in
fig. 1, marked “Use Default”, will return default NMS settings. The button
can have four descriptions and return four different settings depending on
the status of recorder and measurement selection.

1. Use Default: No recorder selected.
2. Use Recorder: Recorder selected but not a measurement

sequence.
3. Use Sequence: Measurement sequence selected.
4. Use Online: Recorder is on-line.
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9.Multiple Intervals

Mercury has the option for setting up more than one sampling interval
within a measurement sequence. Reasons for wanting multiple intervals
can be to save memory, but still be able to have frequent measurements
in between. This may be the case with fish tagging, when frequent
recording is wanted in a specific period in the fish life cycle. If you want to
run on a single interval the whole recording period, this option is not
selected.

By choosing Multiple Intervals (under Settings-Preferences-
Measurement Intervals), multiple interval setup is activated. Thereafter,
choose the Edit menu and New Measurement Sequence Definition
command. The following dialog box appears:

Figure 9.1 Setting new Measurement Sequence (with multiple intervals)
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9.1 Start time

The user defines the date and time when recordings should start.

9.2 Measurement Interval

The sampling interval (time between measurements) is defined. It is any
value from 1 to 99 seconds, or 1 minute to 24 hours with increments of 1
minute. Up to 7 different sampling intervals can be selected. If for example
two intervals will be used, then only two intervals need to be filled out. If
seconds are used as sampling interval, the multiple of the sampling
interval and the number of measurements must be dividable by 60.

Number of Measurements N1-N7
The user defines the number of measurements to be recorded within each
sampling interval. A value from 1 to 60000 must be set. Please note that
an initial measurement is taken at the defined ‘start time’. This initial
recording is not counted as a measurement for the ‘Interval 1’ number of
measurements. For example if the recorder should measure every hour
from midnight to ten o’clock (00:00 – 10:00), then the number of
measurements defined should be 10. Please note that only this one
measurement at the ‘start time’ does not count as a measurement for the
intervals. In this case, the first measurement counted for the ‘Interval 1’ is
at 01:00, and the last measurement is at 10:00, and then it shifts to
another interval.

After taking one measurement at the ‘start time’, the recorder will start on
the first interval in the sequence and take the number of measurements as
defined. After taking the measurements on the first interval, it will
automatically shift to the next interval etc. The sampling intervals and
number of measurements will recycle until memory is full, or until
connection is made with the recorder through a PC computer.

Sequence 1-14
The interval sequence must be filled out. As shown in figure 10.1, the
user selects to use intervals 1-6 for the recordings. Another example:
If two of the first sampling intervals are used, the sequence should be 1,
2, 1, 2 etc., meaning that the recordings shift between the first and the
second intervals, recording the defined number of measurement for the
first interval, and then shifting to the second interval taking the number of
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measurements defined. The shifting between the intervals repeats until
memory is full, or until connection is made through a PC computer.

The Use Template can be used if older definitions have been saved by
enabling the ‘Save this NMS as a template (file)’. That way it’s possible to
get templates that have been set up in the past. With the Use Sequence
button it is possible to get same settings as from other recorders, by
browsing for their serial no. By hitting the Previous button the settings go
back to previous, before changes were made.
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10. Reconvert Data

In Mercury you have the option of reconverting data that has already been
retrieved. After re-defining parameters, the data is reconverted by ‘File -
Reconvert Data’. The main reasons for reconverting data are:

 Shift pressure/depth values according to a reference meter, to
increase accuracy.

 Adjust measurements that are outside calibration range.
 Incorrect PC-time at measurement start time.
 Shortening the data file, i.e. cut out measurements above water.
 Need for temperature or pressure/depth unit alteration.
 Need for data file format alteration.
 (‘Settings – Preferences – Data File Format’).

10.1Data Definition

Under the Edit menu and Reconvert Definition, choose the Data
Definition command, and the following dialog box appears:
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Figure 10.1 Reconvert Data Definition

Set Reconversion Measurement Sequence Start-Time
If the user notes from retrieved data that the PC date and clock were
incorrect when measurements were started, it is possible here to specify
a new start date and start time.

In Reconversion use Measurement Intervals from
The measurement interval is either the interval settings as shown in the
measurement (MID) file, or if that interval is incorrect, a new and correct
sampling interval is specified in the ‘New Measurement Sequence
Definition’ command in the ‘Edit’ menu.

In Reconversion use Constants from
The user can choose to use calibration constants from:
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 MID file. This option should normally be selected, as it contains
information on the constants from the measurement sequence.

 RID file. The recorder information file contains the same calibration
constants as the MID file, except if it has been re-calibrated. If it has
been re-calibrated, and the user wants to use the new constants on
older measurements, the RID option should be selected.

 RBD file. This option rarely needs to be selected. If the constants
from the MID and RID file are corrupt, the user should contact Star-
Oddi for an RBD file. See chapter A.3 for instructions on how to
transmit the RBD files to the recorder.

Convert Number of Data
The user can reconvert all the data in the last measurement sequence, or
define the number of measurements to be reconverted. The user has the
option to define what measurement range should be reconverted (for
example to exclude data points when the recorder was above water).

Time Linear Adjustment
The real time clock inside the DST has an accuracy of approximately +/-
1 minute per month. This slight variation might accumulate over time and
influence the measurement results. To correct the gradual time shift first
check „linear adjustment time“ then type in the time offset value and the
length of the measuring period.

Out of Range Decimal Value Settings
Measurements that are outside the calibration range are inaccurate, and
may give erroneous results. The out of range (OOR) measurements can
be seen in the OOR file. The user has the following decimal value out of
range detection options when reconverting:

 Full scale (no boundaries). This means that literally no ‘out of
range’ detection will be made.

 User definition. With this selection the range definition under
‘Settings - Out Of Range - DV definition’ will be used. This option is
selected when the decimal values (DV) are not available in the RID
file. This would normally require the user to contact Star-Oddi for
the decimal values.

 RID values. The calibration decimal range is given in the RID file.
This is the default option and should normally be selected.
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If an RBD file exists in the \Mercury\RBD folder, then Mercury recognizes
this file as a primary source for DV calibration range. In this case, the
fourth option appears and is set as default.

10.2Temperature Definition

Under the Edit menu and Reconvert Definition, choose the Temperature
Definition command, and the following dialog box appears:

Figure 10.2 Temperature offset Correction Menu

Offset Adjustment
When recorders are used over a long period of time, the temperature
measurements can start to deviate from correct values.
When checking older recorders, it has come apparent that the error in the
measurements is mainly due to an offset. Some users feel they can
benefit from an offset correction option in Mercury, for example when a
recorder has been in the water for a long time and is later tested to show
an offset. The offset is defined in m°C (1°C = 1000 m°C).
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10.3Single Spike Correction

To enable single spike correction choose Edit-Reconvert Definitions-
Temperature Definition (see figure 10.2).

Check Use Single Spike Correction.

There are two variables, Time and Limit. The Limit defines how much
difference can be between two points over a defined Time.

If a point is outside the range, +/- the limit of adjacent points. That point is
then calculated as the average of the adjacent points.

Reconvert Data
After acknowledging the offset adjustments, the data need to be
reconverted, for the adjustments to be effective: <File\Reconvert Data>.

View Previous Conversions
Each time a reconversion is performed, a numbered file is created in the
sequence folder.To view previous conversions select a file under View
and choose Previous as can be seen in figure 10.3.
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Figure 10.3 Previous Conversions

The window in figure 10.4 appears. Select a numbered file from the drop-
down list.

Figure 10.4 Select Previous Conversions
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Reconvert Previously Retrieved Data
If data from the same sequence is retrieved more than once, a
bookmarked data sequence file (DAD) is created. These files can be
accessed and reconverted by choosing File-Reconvert data-Previous as
can be seen in figure 10.5

Figure 10.5 Reconvert Previously Retrieved Data
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11 Recorder Modes

In this chapter, the three operational modes of DST are described, that is
the PC Mode, Sleep Mode and Measurement Mode.

11.1PC Mode

If the recorder is in the correct position in the Communication Box, and by
choosing the Recorder menu and the Connect command, the recorder is
put into PC Mode. At the bottom of the Mercury window, the text On-line
is displayed, indicating that the recorder is on-line and in PC Mode.

While in PC Mode, the recorder will remain in an active listening stage.
The communication protocol is a simple master/slave arrangement, in
which the recorder is the slave. The slave will perform every command the
PC issues, and after execution of a command, it will return to listening.
When the recorder is connected to the PC, it is powered by the PC, and
not taking energy from the battery inside the recorder

11.2Sleep Mode

The user receives the recorder in Sleep Mode, but it can easily be
awakened by the Connect command in the Recorder menu. If the
recorder is not set in Measurement Mode, it goes into Sleep Mode when
the recorder is removed from the Communication Box. When the recorder
is in this mode, less energy is depleted from the battery.

11.3Measurement Mode

The recorder is put into Measurement Mode by choosing the Recorder
menu, and Start New Measurements Sequence. The recorder starts
recording measurements according to the start time (date/month/year)
and sampling interval (hours/min.) defined by the user.

When the memory is full, the recorder shifts automatically into Sleep
Mode. If the recorder is still in Measurement Mode upon connection
through a PC computer, it stops recording and is put into PC Mode.
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12 Memory Organization

Data is kept in an EEPROM memory and will not be lost if the battery fails
or expires. The memory of the recorder is organized as shown in the figure
below:

New recordings
Unused memory/
Old recordings

VV Data memory

Settings V

Figure 12.1 Data Memory Organization

When data is retrieved from the recorder, the following occurs:

1. The computer retrieves the data from the recorder and writes the
data to the computer’s hard drive .

2. The recorder has stopped recording, but still holds the recorded
data.

When new settings are sent to the recorder, the following will occur:

1. New settings are sent to the recorder.
2. The data memory pointer is reset to the beginning of the data

memory and starts to write over older recordings.

The organization of the memory is now as follows:

Unused memory/
Old recordings

VV Data memory

Settings V

Figure 12.2 Data Memory with new Settings
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Appendix

A.1 Directories and Files

Directory Structure
The user can choose between Mercury’s default data directory structure
(path) or define his own data path. As the Mercury program is a multi
recorder type program, the directory structure branches from the directory
where Mercury is positioned down to type directories, i.e. DST micro,
DST milli etc. From there it branches again into recorder directories,
named after the serial numbers of the recorders, designed to hold data for
each individual recorder (data directory). All in all it is a three level
directory structure.

An example of this directory structure with DST centi is:

C:\Mercury\ The installation directory (Mercury.exe location)

C:\Mercury\DST centi\ The type directory for DST centi

C:\Mercury\DST centi\C2018\ The directory for the C2018 recorder

When a new recorder type is selected in Mercury (File – New Recorder
Type), the directory for that recorder type is created. When connecting to
a recorder for the first time, Mercury creates the recorder directory,
named after the serial number of the recorder.

Information Files
Mercury uses information files to store and retrieve settings. There are
two types of information files:

1) The type-INI files, (for example DSTc.ini for DST centi).
The information type files are all in the installation directory, they
contain information on specific settings for each type. The type-INI files
are:
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StarmonT.ini Starmon mini
DSTm.ini DST milli
DSTr.ini DST milli recycle
DSTu.ini DST micro
DSTc.ini DST centi/centi ex
DSTs.ini DST CTD
DSTn.ini DST nano
DSTx.ini DST pitch & roll

2) The recorder-INI files, for example C2018.ini contains settings
information and data file positioning for the C2018 recorder. The
recorder-INI files are located in the appropriate type directory, i.e. all
the Cxxxx.INI files are in the ‘DST centi’ directory.

Files Locations
As stated previously, the type-INI files are placed in the ‘Mercury’
directory, and the recorder-INI files are placed in the recorder type
directory. All other recorder and measurement related files created by
Mercury, are placed in the appropriate recorder’s directory. For example:
C:\Mercury\DST centi\C2018\ is a directory for the C2018 recorder and
all files belonging to C2018 are placed there.

If the user whishes to use his own defined data path, for example
C:\Data\, then all the files for all the recorders, except for the INI files, are
placed there. If the user has enabled the “Create recorder directories” in
the user path definition, individual recorder directories, irrelative to type,
are created under the user defined path, for example: C:\DATA\C2018\
for the C2018 recorder. The C2018.ini file (located in the
C:\Mercury\DST centi\) contains the path to the C:\Data\C2018\
directory, and all files related to the C2018 will be placed in that
particular directory.

Browsing for a Recorder
When browsing for a new recorder from the ‘Select recorder’ under the
files menu, the default method is to find a recorder-INI file in the type
directory. The INI file will then point to the data directory (the recorder’s
directory). If the user has enabled the “Browse first in the user directory”
in the user path definitions, the search starts in the user defined directory,
where a *.RID file must be selected.
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Recorder Related Files
Every file that is recorder related has the following name format:

Cxxxx: The name is the serial no. of the recorder

Ext Description File type
RID Recorder information data Binary
RIT Recorder information text Text
RBD Recorder backup data Binary
RDD Recorder SNMS* download information data Binary
RDT Recorder SNMS* download information text Text

*SNMS: Start New Measurement Sequence

The recorder ID (RIT) can at a later time be opened, and the related
measurement data can be viewed, printed and reconverted. The RDD,
RDT and DIR are download information files, created when a new
measurement sequence is started.

Measurement Related Files
Every file that is specifically measurement related has the following name
format:

mmmCxxxx: The name is the measurement number + serial no.

Ext Description File type
MID Measurement information data Binary
MIT Measurement information text Text
MDD Measurement download information data Binary
MDT Measurement download information text Text
CIT Measurement conversion information text Text
DAD Measurement Data Binary file Binary
DAB Measurement Data Binary file Text
DAT Measurement Data Binary data Text

The MID, MIT and DAD files are created upon measurement data retrieval
from the recorder. The DAB, DAT and CIT files are created when
converting the data. The MDD and MDT are download information files
and created when a new measurement sequence is started.

Data Files
Upon data retrieval, three main data files are created.
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The *.DAD File
This file is the raw data source file. The data is in mixed binary form. The
user cannot access this file in the Mercury program. When converting
these raw data into measurements, the *.MID file is needed. The result
from the conversion are two data files, the *.DAB and the *.DAT.

The *.DAB File
This file contains sequential binary representation of the data in columns.
The first column is the measurement number. The other columns contain
the measured parameters in a binary form.

The *.DAT File
This is the actual result file, where the measurements are converted to
their natural units and timed. This is a text file with columns. The first
column is the measurement number, the second column the date and the
time, depending on the set-up. The third column is the time or the first
measured parameter, depending on set-up. The following column(s)
contain the converted measured parameters with units and number of
decimals according to set-up. Number of parameters can range from 1-3,
and number of columns 3-6 accordingly.

Data Header
The *.DAT file contains a data header, which is a detailed description of
how the *.DAT file is configured. This feature is used by Mercury when
graphically representing the data, and is practical if the user wants to
import the data into other applications or databases. Most of these
descriptive items are derived from the ‘Settings’ menu and the recorder
type definition in the ‘File’ menu.

Each header item is contained in one line, and all header lines start with a
# (bookmark) and a number. Then follows a description of the header
item, and then 1-4 directives, all separated by tabs. Eventually a comment
trails the directives, preceded by a ; (semicolon)

The following is a description of the directives contained in the data
header.

Item Description Number of directives

#0 Date-time: 1
The date and time of that particular *.DAT file creation.
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#1 Recorder: 1
The recorder and sequence number, f. example 12M1023
Used for confirmation and as a graph header.

#2 File type: 1
Describes file column structure, mainly if Date and Time are joined
(0-3)
0: Result file Number Date Time Channels 1-3
1: Result file Number Date & Time Channels 1-3
2: Binary file Number Binary Channels 1-3

#3 Columns: 1
Total number of columns (3-6).

#4 Channels: 1
Number of measurement parameters (1-3).

#5 Field separation: 1
Separation between columns (0,1)
0: Tab
1: space

#6 Decimal point: 1
(0,1)
0: Comma
1: Dot

#7 Date def.: 1
Date format (0,1)
0: dd mm yy
1: mm dd yy

#8 Time def.: 1
Time separation (0,1)
0: Colon (:)
1: Dot (.)

#9 Channel 1: 4
Set as left axis, normally temperature. The four directives are:
Axis header, unit: Text
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Column header, unit: Text
Number of decimals: (0-3)
Axis direction (1,2)

1: Ascending
2: Descending

#10 Channel 2: 4
Set as right axis. The four directives are:
Axis header, unit: Text
Column header, unit: Text
Number of decimals: (0-3)
Axis direction (1,2)

1: Ascending
2: Descending

#11 Re-conversion: 1
Definition on conversion / Extra header in graph (0,1)
0: Original conversion
1: Reconverted
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A.2 Help Menu

Choose Help and the following window appears:

Figure A.1 Help Menu

User Manual
Select User Manual to open the Mercury user manual.

Troubleshooting
Select Troubleshooting to open the Trouble-Shooter.

Release Notes
Select Release Notes to view a description of the latest features added
to Mercury, the date when they were added and a reference to the
chapter number of each manual where the additions can be found.
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About
Select About for general information about Mercury.

Check for Updates
By selecting Check for Updates Mercury will automatically search the
Star-Oddi website for the latest version of Mercury, User Manual,
Trouble-Shooter and Release Notes. The program downloads and installs
the latest updates to the software. Please note that this can only be done
when the program is offline i.e. when no recorder is connected to the
program.

This is also done automatically every 30 days.

A.3 Recorder Backup

As mentioned in chapter 10, if the constants from the MID and RID file
are corrupt, the user should contact Star-Oddi for a RBD file and transmit
it to the recorder.The name of the backup file is Txxxx.RBD (serial no. of
the recorder plus the .RBD ending).

Downloading the backup file:

1. Copy the backup files (RBD) into the Mercury RBD directory.
2. Open the Mercury software.
3. Plug a recorder to the PC computer.
4. Select the 'File' menu and 'Recorder backup' command and the

following window appears:
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Figure A.2 Select a Recorder *.RBD file

Browse for the correct RBD file on the computer and click OK.
5. Insert the sequence number and remaining battery life (see figure A.3).

Note that if the sequence number is set too low, data will be
overwritten.

Figure A.3 Set Sequence Number
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6. The Mercury software downloads the RBD file into the recorder and
the window in figure A.4 appears. Click OK.

Figure A.4 Backup Operation
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